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EXCEL ADVANCED

1. Statistical functions (Review)

It is possible to manually enter the formula or function without the assistance of the tools. It should be
remembered, however, that Excel needs very specific instructions, the syntax of the formulas must be
respected when it comes to typing them or an error is generated.

EXERCISE Statistical function
Open the file « Formulas step 1 », sheet « Review 1 »
1. Activate cell B8 to get the average of "Session 1"

2.  Type =AVERAGE, type parenthesis " ( + the cells containing the results of "Session 1" )
=AVERAGE(B3:B7), the result is "41.25"

3. If you want to get the "Maximum" grade, type "MAX" or for the "Minimum" grade, you will

type "MIN"
4. Click OK
1.1. Definition of basic functions.

FUNCTIONS | EXPLANATION

SUM Adds all the numbers in a range of cells.

MAX Returns the largest value in a set of values. Ignores logical values and text.
MIN Returns the smallest number in a set of values. Ignores logical values and text.
AVERAGE

Returns the average (arithmetic mean) of its arguments, which can be numbers or names, arrays, or references that contain numbers.

COUNT Counts the number of cells in a range that contain numbers.
COUNTA Counts the number of cells in a range that are not empty.
Note :

EXCEL ADVANCED Page |3



FORMATION CAD INC

2. RELATIVE OR ABSOLUTE ADDRESSES

2.1. Relative address:

X Whose formula adjusts during a copy.

Example of RELATIVE ADDRESSES:

Amount Description Price Total
20 Computer 2000 =A2*C2
25 DVD 275 =A3*C3
15 iPad 950 =A4*C4
2.2. Absolute address:
X Fixed address, it does not change during a copy.
Example of ABSOLUTES ADDRESSES:
Description Price Gst Qst
5% 9,975%
Computer 2000 B3'$C$2 =B3*$D$2
DVD 275 B4-$C$2 =B4*$D$2
iPad 950 B5-$C$2 =B5*$D$2

2.3. Mixed address:

X Relative column and absolute line: B$2. Row 2 stays fixed, while the column adjusts when
copying. In our case below, by copying the formula to the right, Excel calculates the timelines
of each row from the deadlines located only in row 2 for each column.

X Absolute column and relative row: $A3. Column A remains fixed while the row adjusts when
copying. In our case below, by copying the formula down, Excel calculates the timelines of
each row from the dates located only in column A.

Example of RELATIVES AND ABSOLUTES ADDRESSES

2.4.

Billing Date DEADLINE 1 DEADLINE 2 DEADLINE 3 DEADLINE 4
30 60 90 360
2023-09-15 =$A3+B3$2 =$A3+C$2 =$A3+D$2 =$A3+E$2
2023-08-21 =$A4+B3$2 =$A4+C3$2 =$A4+D$2 =$A4+ES$2
2023-09-18 =$A5+B3$2 =$A5+C$2 =$A5+D$2 =$AS+E$2

F4 key, to get absolute reference.

X The cell chosen to perform the formula remains the same. Excel returns to the same column

and line when copying.

EXCEL ADVANCED
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3. Transpose: Going from rows to columns

Open the file « Formulas step 1», sheet « Transpose »
1. Select cells A2 to M12
2. Click the Copy button on » Home tab » Clipboard Group

, Birth Statistics by Province

PROV. January February March April May June July August September October November December
2
3 Qc 7865 5678 7654 3456 5432 5643 5675 2345 9876 87167 2345 5634
4 ON 5675 2345 9876 7865 5678 7654 5678 7654 7865 5678 1321 2345
5 BC 3456 2345 3456 5643 4532 2345 5678 7654 3456 5432 3456 5643
6 AL 2345 9876 7865 5678 7654 9876 8767 5675 2345 9876 7865 5678
7 MA 5643 5675 2345 5675 2345 9876 7865 5678 131 2345 3456 5643
8 SA 3456 2345 3456 5432 5643 5675 2345 3456 2345 3456 5643 4532
- NE 1234) 997 987 1321 945 945 899 1112 999 876 123 899

'

10 NB 987 1234 997 1321 945 899 1112 876 123 956 1321 876
1 TN 564 987 1234 997 987 1321 945 899 1112 999 876 123
12 IPE 987 1321 945 899 1112 876 1231 956 1321 1123 956 121

Activate cell A15 to change the row and column headers

4.  From » Home tab » Clipboard Group » Paste » Paste Special » choose » Transpose
from the "Paste Special" dialog box

5.  Or right mouse button » choose »

Paste Options:

2o Ay o

6. Click OK, here's the result below

«0V. Qc ON BC AL MA SA NE NB TN IPE

January 7865 5675 3456 2345 5643 3456 1234 987 564 987
February 5678 2345 2345 9876 5675 2345 997 1234 987 1321
March 7654 9876 3456 7865 2345 3456 987 997 1234 945
April 3456 7865 5643 5678 5675 5432 1321 1321 997 899
May 5432 5678 4532 7654 2345 5643 945 945 987 1112
June 5643 7654 2345 9876 9876 5675 945 899 1321 876
July 5675 5678 5678 8767 7865 2345 899 1112 945 1231
August 2345 7654 7654 5675 5678 3456 1112 876 899 956
September 9876 7865 3456 2345 1321 2345 999 1231 1112 1321
October 8767 5678 5432 9876 2345 3456 876 956 999 1123
November 2345 1321 3456 7865 3456 5643 1231 1321 876 956
December 5634 2345 5643 5678 5643 4532 899 876 1231 4
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4.1.

4.2.

4.3.

4.4.

Date function

Option 1: Date that will not be updated

X Activate the destination cell to insert the date of the day.

w  Press the "CTRL" button, then the "semicolon” ";" button. Today's date appears.

"CTRL + ;"

Option 2: Date to be updated

X We want to insert a date that will be updated in future use of the workbook. How do | do
that? Activate the destination cell, TYPE: The sign = and type TODAY, add an opening and
closing parenthesis (). Confirm with Enter«”

=TODAY()

To change the date format
1. Select the cell to be formatted.

2. Using the pop-up menu obtained by clicking with the right mouse button, click » Format
Cells » Font tab of the Home tab

3. Tab » Number, in Category, choose option » Custom.

4. Inthe typical area, enter the following code: d mmmm yyyy

Function: YEAR — MONTH — DAY

This function is used to retrieve from a date, either year or month or day.

Open the "Formulas1l Workshop" file, "Employees" sheet

1. Activate cell "B2" In "Function Library" of the "Formulas" tab,
2. Click on "DateTime" Choose either "YEAR OR MONTH"

=)
L,

(

Date &
3. In"Function arguments”, click on "A2" » Tima v
=YEAR(F2)
Number

1 Hiring date |~ Month or Year |~ hours -l Hourrate |~ Salary weel ~ 1 |.|"".|g date | ~ | Month or Year |~
2 2012-10-05|=YEAR(F2 l 20 2350 §
3 | Function Arguments 7 K 2 2012'10-05 2012
AR FYEAR 3 2016-11-18 2016
5 | Serial number  F2| + = angr
6 = 2 4 2015-06-07 2018
7_ Returns the year of a date, an integer in the range 1900 - 9999,
87 Serlal_number is a number in the date-time code used by Microsoft Excel. 5 2022-04-09 2022
9: Formula result = 2012 6 2022-09-12 2022
08 1510 on this function oK Cancel 7 2022-11-12 2022

EXCEL ADVANCED
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5. Formulas: INT

This "INT" formula represents rounding down one number to the nearest integer. This function is
equivalent to "ROUNDED. INF" (Integer value)

1.
2.

N o o b~ w

10.

Type the age in cell A1, someone who was born in 2000 and that his birthday is tomorrow

In cell A2, type the following formula: TODAY() WHICH REPRESENTS TODAYS DATE
(DYNAMIC DATE)

TODAY() MINUS HIS DATE OF BIRTH, CELL A1,

Parenthesis for "' (TODAY() AND A1) " then divide by 365.25
This person will be 23 years old tomorrow only
Click in the Formulas tab

Choose: INT from MATH &TRIG, or type in front of your formula =INT( then close your
parenthesis at the end. Do not touch inside of the formula.

Watch your result: THE VALUE IS 22
Tomorrow, your result SHOULD BE 23

To save a step: in cell A2, type the following formula:
A2 v i Jx [ =INT({TODAY{)-A1)/365,25)
A B cC [
1 2000-10-02
2 22

Here is an example with the month and day "Today" but born in "2000"

If necessary, open the " Formulas Step 1", "TODAY_NOW" sheet.

1.

w N

L. O G G I

In cell C2, type the following formula: TODAY() which represents today's date (DYNAMIC
DATE)

In cell C3, type the following formula: NOW() which represents the date and time of the day.
In cell "C5",

Enter the year 2000.

The current month

The day of "Tomorrow"

In cell "C6," enter the following formula:

TODAY () MINUS HIS DATE OF BIRTH

=TODAY()-C5 Age in days £399

Cell "C7", in parentheses "(C2 or TODAY() — C5)", then divide by 365.25

=(TODAY()-C5)/365,25

Age in years 2299520676

EXCEL ADVANCED Page |7
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Cell "C8", you must obtain the integer value with the function "INT"
Or you type = INT and click in cell C7, close parenthesis

Or Add "INT" immediately after "=", we have opened a parenthesis, so we must close it at
the end of the formula.

=INT({TODAY(}-C5)/365,25)

x |n cell "C5", replace the day for today's According to our calculations, age should have an
additional value
We add +1 like this:

| 2000-10-02 23 =INT{{TODAY ()-E3+1)/365,25) AGE WITH "INT" - Goop 1 |

Now let's see the other formulas for age calculation
Look at the dates that are in column "E to H”

Anniversary AGE

FORMULA DESCRIPTION
date

2000-10-02 23 =INT(YEARFRAC(E2;TODAY())) AGE FRACTION - GOOD

AGE WITH "INT" - GOOD
\y

2000-10-02 23  =INT((TODAY()-E3+1)/365,25) g)

=INT((TODAY()-E4)/365,25) FORMULA USED - NOT GOOD
2000-10-02 22  For Excel, the age will be change

after the end of the day if we don't take time into account E]

AGE WITH "DATEDIF"

2000-10-02 23 =DATEDIF(E5;TODAY();"y"
( (:"¥") Very GOOD but not in the formulas "DATE"

6. NETWORKDAYS

This formula calculates the number of days between two dates, considering Saturday, Sunday, and
holidays.

Open Formulas Step 1, NETWORKDAYS sheet
X Cell « C2 »

» |n "Function Library", Book "Date & Tim", choose "NETWORKDAYS"
x  Select A2 for "Start_date"

»  Then B2 for "End_date"
X Select A8 to A10 (All your holidays)

EXCEL ADVANCED Page |8
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X Touch F4 to lock cells.
X The result is: 16

X Representing number of days without Saturday and Sunday and holidays

Function Arguments

NETWORKDAYS
Start date A2 2| = 45240
End date B2 4| = 45261
Holidays | SAs8:5A$10] 2| = (45241:45285:45292

= 16
Returns the number of whole workdays between two dates.

Holidays is an optional set of one or more serial date numbers to exclude f)
such as state and federal holidays and floating holidays.

7. SUMIF

This function allows you to make the sum of a range according to a criteria.

This criteria can apply on the range you want to add or on another range with the sole condition that the
two ranges are the same size. Its syntax is SUMIF ([range], [criteria], [sum_range]) where

Range represents the range on which the criteria will be applied, it can be the same as "'sum_range"

X Type these data in a sheet
A

B
1 Emergency 22
2 Surgery "
3 Emergency 55
4 Medicine 10
5 Surgery 33
6 Surgery 45

X Criteria must be in the form of a number, text, or expression of comparison. This criteria
must be placed in quotation marks and cannot depend on a cell. Example: "<>10"
(Different from 10)

X Sum_range is the range on which the sum will be applied.
The function will cover the range and for each cell X, it will check whether the cell Y, from the same

position in the range sum_range, actually meets the condition indicated in criteria, if so, it adds the value
of the X cell to the result. Example:

A B e D E F G
guments ?
Sum of the set > | Sugery b
Answer: 176 e
. 3 Emergency 55 Range  Al:48 4 | = {Emergency’;"Surgery’;"Emerg
4 Medicine 10 Criteria | “Surgery” 4 | = “surgery”
5 Surgery 33 sum_range |B1:86 + | = (221155103345
6 Surgery 45 - 89
7 Adds the cells specified by a given condition or criteria.
g [sumiF: SURGEP\‘(l"Surgery";Bl:Bﬁ] | Range is the range of cells you want evaluated.
o
i Formula result = 39
o Help an this functian ol
12

FORMULA: =SUMIF(A1:A6;"Surgery";B1:B6)

EXCEL ADVANCED Page |9
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3. COUNTIF

This function counts the number of cells corresponding to a criteria in a range. It works much like the
previous function. Its syntax is COUNTIF([range] , [criteria]) - range represents the range that will be
counted.

X Criteria must be in the form of a number, a text, or an expression of comparison. These
criteria must be put in quotation marks and cannot depend on a cell. The function runs
through each cell in the range, if the content of that cell corresponds to the condition
indicated in the criteria, it adds 1 to the result.

Example: COUNTIF
X |n the previous table, how many lines contain the word "surgery"
X |n cell B9, type = COUNTIF(

X In Range, choose Al to A6

x  Criteria: Type: "'Surgery"

A B
1 Emergency 22 Function Arguments
2 Surgery " COUNTIF
3 Emergency 55 Range |a1:48] + | - [Emergency Surgeny: Emergency ...
4 Medicine 10 Criteria | “Surgery” + | = “Surgery
5 Surgery 33 = 3
z Surgery 45 Counts the number of cells within a range that meet the given condition.
- Range is the range of cells from which you want to count nonblank cells.
g |SUMIF: SURGERY 89
2 COUNTIF "Surgery") Al Formula resuit = 3

»  =COUNTIF(A1:A6;"Surgery") =3

9. LARGE - SMALL

This function returns the k-to highest value (or smaller value) of a data series. You can use this feature to
select a value based on its rank. So, you can use the LARGE function VALEUR to return the highest result,
the second or the third. SMALL to return the smallest result, the second or the third.

" ” . o
Example: "LARGE If you like to get the second highest value,
In the previous table, what is the largest value in column B CHANGE "K"
=LARGE(B:B;1)= 55 ("K1" represent "the greatest value") TO READ "2" INSTEAD OF "1"
Emergency 22 Function Arguments
Surgery 11
Emergency 55 LARGE
Armray | B1:B6| = (22;11;55;10;33;45}
Medicine 10
K |1 +] =1
Surgery 33 -
Surgery 45 Returns the k-th largest value in a data set. For example, the fifth largest number.
Array is the array or range of data for which you want to determine the k-th
EUMIF: SURGERY 89 targest value.
COUNTIF 3
LARGE @l Formula result = 55
SMALL *| Help on this function Cancel

In the previous table, what is the smallest value in column B
=SMALL(B:B;1)= 10
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10. AVERAGEIF

The function AVERAGEIF () refers to the average (arithmetic) of all cells that meet several criteria.

=AVERAGEIF ([range];[criteria];[average range])
Where:

Range is the range of cells you want evaluated.

Criteria is the condition or criteria in the form of a number, expression, or text
that defines which cells will be used to find the average.

Average_range are the actual cells to be used to find the average, If omitted, the cells
in range are used .

Function Arguments

AVERAGEIF
Range EZ:BEI + = {YES","YES","MO";"YES"}
Criteria | "YES" + = "YES©
Average_range |C2:C5 | = {5623

= 4666666667
Finds average(arithmetic mean] for the cells specified by a given condition or criteria.

Range is the range of cells you want evaluated.

Formula result = 467 §
Help on this function Cancel

=AVERAGEIF(B2:B5;"YES";C2:C5)

L A B C

I 1 |Fruit basket Purchase Price
2 |Apple YES 5,00 §
3 |Pear YES 6,00 5
4 |Banana NO 2,00 5
5 |Orange YES 3,00 §
6 |Average purchase price 4,67 S_
7 |Average 4,00 §

10.1. Some condition with text

X  "au*' or "au" or "™au" - all words beginning with 'au’, all words ending with ‘au’, all words
containing in.

X A star can replace any character and does not specify the number of characters replaced.
Au* will find aux and others.

You can also use a 2", this one will replace only 1 character,

Example: au? will find aux, but not others.

EXCEL ADVANCED Page |11



FORMATION CAD INC

11. Function IF

Using "IF" to check a condition, then (what should be done?) if not (What to do?)

If A2 is greater than 40000, then multiply A2 by 5%, if not (in all other cases, 0 or "
IF (A2>40000) A2*5% Oor™

[logical_test] [value_if_true] [value_if_false]

Function Arguments

Logical_test |A2>40000 4| = TRUE

A B WValue_if_true | A2*5% 4+ = 2400
1 |Amount sale Bonus Value_if_false |0 +| =0
2 48 000,005 |A26%:0) | = 2400
3 40 500,005 202500 % [Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE,
4 : 45 000,008 225000 % Logical_test is any value or expression that can be evaluated to TRUE or FALSE.
5 | 38 000,005 - %
6 37 500,00% - 5
i b Formula result = 2 400,00 $

. . . n n
Allows the use of comparison operators: > < = <= >= <> Text must be in quotation marks

Example: IF

Open “Formulas Step 17, “Statistics” sheet

If the city is not "Montreal’, Yes for "expenses account”, IF FALSE "No" (to read
in the cell (Column E)

Click on cell E2.
x  Type =IF(
x  Click in B2. Type £=/(these'2'signs together mean not)
X Text Montreal under quote
[logical_test] B2<>"Montreal"
X Coma or semicolon
X [value_if_true] type "YES"
X [value_if_false] type "NO"
X Close parenthesis
E2 = e =IF(B2<>"Montreal";"YES";"NQO")
A B C D E
Name - | Head offi | Post - .::I'::unt - aE:Dp:unniesv
E |Allaire, Sylvain Sherbrocke  President 48 000,008 YES .
B |Allard, Cosette Sherbrooke Vice-Prezident 40 500,008 YES
¥ |Allard, Marie Kontreal President 45 000,008 MO
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12. Function AND

Returns TRUE if all arguments are TRUE; FALSE if at least one of the arguments is FALSE.

X This function is usually used nested in another logical function

X Condition: Exam 1 — 2 and 3, note must be greater or equal to 60:

X Value "TRUE" is "Success", value FALSE is "Failure"

=IF(AND{B2»=60;C2>=00;D2>=60);"Success";"Failure")
A B C D E
1 |Participants Exam 1 Exam 2 Exam 3 Result
2 |Caorinne Paris T4 65 73 Success
3 |Pierrette Paguin Ta 74 63 Success
4 |André Dupuis 69 63 70 Success
5 |Martine Gendron 66 56 64 Failure
& |Pascal Bubois 52 60 1] Failure

13. Function OR

X Returns TRUE if one of the conditions is TRUE and the FALSE if all the conditions are FALSE

X The OR function is usually used nested in another logical function.

Examples of formula: IF &"OR"

X Condition: Sale >=30000

X Or Experience >=5 (years)
X  Value "TRUE": Commission 10%
x

Value FALSE: Commission 5%

=IF(OR(B2>=30000;C2>=5);B2*10%:B25%)

L= T, R - S V6 R L

A B C D
SALE OF THE = EXPERIENCE  COMMISSION
NAME MONTH (YEAR) (%)

PARIS, Christine 32 000,00 % g | 320000 %
PARIS, Corinne 35 000,00 % 3 350000 5
VEZIMA, Andrée 25 000,00 % B 2 500,00 %
BEAUDRY, Pierre 42 500,00 % 7 4 250,00 %
BOUCHARD, Etienne 22 500,00 % 1 112500 5

EXCEL ADVANCED
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14. Function ISBLANK

Copying a formula that refers to an empty cell causes a null result to appear or an error message to
appear. This function is often combined with IF

The following example results with EMPTY CELL "Column G". To avoid these problems, as in column
G, the following formula will be used:

=IF{ISBLANK(G3);"UNPAID";"PAID"

You can use this formula also:

=IF(G26="";"UNPAID";"PAID")

15.  TEXT FUNCTION

15.1. UPPER CASE

F G
BILLING PAYMENT
TRACKING RECEIVED
PAID _| 2020-10-05
PAID 2020-10-25
UNPAID
PAID 2020-10-20
UNPAID
PAID 2020-11-14
UNPAID
UNPAID

To convert text to upper case, here's how to do it:

1.

o g > w N

Open a new file

Typ
Clic

e your last name into cell A1

k in the Formulas tab

Choose: TEXT
Choose: UPPER

In Function Arguments: click in cell Al
A B = D E F G H I |
1 [richard AL) |
Sl o ction Arguments
3
4 | UPPER
5 | Text | A1 4+ = ‘richard"
6 | = "RICHARD"
7 | conwerts a text string to all uppercase letters.
8_ Text is the text you want converted to uppercase, a reference or a text string.
2
10 | Formula result = RICHARD
11
12 | Help on this function Cancel

EXCEL ADVANCED
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15.2. LOWER, PROPER, TRIM, SUBSTITUE
x  LOWER: CONVERT YOUR TEXT TO LOWER CASE
»  TRIM: Delete spaces before and after but not between

»  PROPER: Get the first letter of each word in capital letter:
example: anna maria for Anna Maria or
jean-pierre for Jean-Pierre

x  SUBSTITUTE: Replaces existing text with new text, this function will also delete space

in a cell.

Example
QC12349876  |REPLACE"QC"BY"oN" | ~—>YBSTITUTE(ALTQCTTON') | ane934 9876
QC123456789  DELETE ALL SPACES bl o M QC123456789

A\
To replace or remove the original cells, you need to copy and then
paste the value.

15.3. CONCAT

Union of 2 or 3 columns in a single cell
Here's how to get your first and last name in one cell:

15.3.1. First method
1. Type your first name in cell A1 and your last name in cell B1

2. Incell C1, click in the Formulas
tab =CONCAT(AL;" ";B1)

A | B C o | E | F | G | H

3. Choose: TEXT 1 |muriette Richard |-CONCAT(AL;" “;B1) l
2,
3
4. Choose: CONCAT 4|
5
= Text1 | A1 4| = “Muriell
5. In Function Arguments CONCAT: S Toz z] - -
s | Text3 [Bi 2| = “Richard
6. Text 1: Click in cell A1 o] o 2 - e
‘n* = “Murielle Richard"
7. Text 2: Make your space ::, Concatenates a list or range of text strings
4 Text3: texti;text2:..are 1t 254 text strings of ranges to be joined to a single
(keyboard) | g
. . 16
Text 3 C“Ck in Ce” Bz 47 || Fermula result = Murielle Richard
18 || Help on this function Cancel

Watch your result
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15.3.2. Second method

W

Type your first name in cell A1 and your last name in cell B1
In A2, type =
Click in cell A1

Type & (located above number 7)

To insert a space between your first and last name, type ' (quotation marks,

space, quotation marks)
Retype &
Click in cell B1 then enter

Here is the formula and the result:

=A1&" "&B1
A B
1 Murielle  lRichard
2 |=a18""&s81| |

15.4. LEFT, RIGHT

Steps to get one or a few characters in a cell

1.

2
3.
4

5.

6.

Type your name in cell A1
Click in the Formulas tab
Choose: TEXT

Choose: LEFT or RIGHT

= “Ric
Returns the specified number of characters from the start of a text string.

A B c [ o | E | F | @6
1 |Richard I=LEFT(A1;3)
2
:
4 || LEFT
5 Text A1 2| = “Richard®
¢ Num_chars 3| 2] =3
7 L
8
9

Num_chars specifies how many characters you want LEFT to extract; 1 if omitt

N = |0

Formula result = Ric

Help on this function ' oK ' Cancel

w

In Function Arguments: Text: Click in cell A1 Num_chars: Choose the number of

characters needed

Observe your result which is RIC

EXCEL ADVANCED
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16. CONVERTING DATA

This function allows us to separate the text of a cell into several columns. Or for example, to convert a date
that is in TEXT format into a DATE format

c
B San Franci )
7886 rve 1
BISTRO DES BIERES BELGES 60 Rue Saint-Jean Longc‘:.::ﬁ“e ac PV
1 |Francine Thibault RESTAURANT LOU NISSARD 3y e Bl 3: =
int-Jacques
2 |Céline Marcou gOSTON P‘ZZ/:;ouES 6710 Rue s:m-n:au oliste
Barbeau 0 STJA
BISTR

17. Convert

This function allows us to separate the text of a cell into several columns. Or for example, to convert a date
that is in TEXT format into a DATE format

A | B | C | D | E |
_|Francine Thibault, CLOG-001, BISTRO DES BIERES BELGES, 7886 rue San Francisco, Bouchemille, QC, J3T 4R8
_|Céline Marcoux, CLOG-002, RESTAURANT LOU NISSARD, 260 Rue Saint-Jean, Langueuil, QC, J4H 2X5

_|France Barbeau, CLOG-003, BOSTON PIZZA, 9534 rue Belleville, Bouchenlle, QC, J3P TV&

_|Cosette Allard, CLOG-004, BISTRO ST-JACQUES, 6710 Rue Saint-Jacques, Montréal, QC, H4B 1Va

_|Joe Bloe, CLO6-005, PIZZA HUT, 3 Rue Papineau, Joliette, QC, JGE 3A1

[ T =S S B N

17.1. Convert text
X  Select Alto A5
X  From the Data tab

X Click in Convert (Text to Columns)

Text ta
Columns
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x

) GEED_GHED GEED ¢

x

Choose Delimited in Step 1 of 3

Convert Text to Columns Wizard - Step 10f 3

The Text Wizard has determined that your data is Fixed Width.
If this is correct, choose Next, or choose the data type that best describes your data.
Original data type
Choose the file type that best describes your data:
© Delimited - Characters such as commas or tabs separate each field.

(O Fixed width - Fields are aligned in columns with spaces between each field.

Preview of selected data:

rancine Thibault, CLO6-001, BISTRO DES BIERES BELGES, 7886 rue San Francisco, Bouc 4
éline Marcoux, CLO6-002, RESTAURANT LOU NISSARD, 260 Rue Saint—Jean, Longueuil, OC,
rance Bazbeau, CLOG-003, BOSTOM PIZZA, 9534 rue Belleville, Boucherville, OC, J3P
osette Allard, CLO6-004, BISTRO ST-JACOUES, 6710 Rue Saint-Jacques, Montzéal, OC,

o¢ Bloe, CLO6-00S, PIZZA HUT, 3 Rue Papineau, Joliette, QC, J6E Al

Cancel < Back Enish
Next > (Step 2 of 3)
Choose the comma.
View the result in the Data preview.
Click Finish _ - -
Convert Text to Columns Wizard - Step 2 of 3 ? ® |

This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview below.

Delimiters

B b

G Semicolon fj Treat consecutive delimiters as one
Text gualifier: |~ e

O] other:

Data preview

rancine Thibasult | CLO§-001 | BISTRO DES BIERES BELGES | 7886 rue San Francisco | Bouched &
éline Marcoux CLO&-002 | RESTAURANT LOU NISSARD 2860 Rue Saint-Jean Longue
rance Barbeau CLO6-003 | BOSTON PIZZA 9534 rue Belleville Bouche
osette Allard CLO&-004 | BISTRO ST-JACQUES €710 Rue Saint-Jacques | Montré
oe Bloe CLO€-005 | PIZZR HUT 3 Rue Fapineau Joliet
v
Cancel < Back Mext = | Einish

Result
| A | B | Cc E F
1 |Francine Thibault BISTRO DES BIERES BELGES 7886 rue San Francisco  Bouchenille QC J3T 4R8
2 |Céline Marcoux RESTAURANT LOU NISSARD 260 Rue Saint-Jean Qc J4H 2X5
3 |France Barbeau BOSTON PIZZA 9534 rue Belleville Qc J3P TVE
4 |Cosette Allard BISTRO ST-JACQUES 6710 Rue Saint-Jacques Qc H4B 1v8
5 |Joe Bloe PIZZA HUT 3 Rue Papineau Qc JBE 9A1
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17.2. Convert to Fixed Width

Our goal will be to separate the first two letters and numbers;
however, we must keep the zeros.

) GEED_GHED GEED ¢

9 |AW02345
10 |MY00345
11 |LI8346

¢ | Separate the letters from the numbers but keep the "ZERO"

Original data type

Choose the file type that best describes your data:

Delimited - Characters such as commas or tabs separate each field.

° Fixed mdlh’ - Fields are aligned in columns with spaces between each field.

Select from A8 to A10
From DATA, Text to columns

In "Convert Text...", choose "Fixed Width" Go to "Next."

Click between letters and numbers

Convert Text to Columns Wizard - Step 2 of 3

This screen lets you set field widths (column breaks).
Lines with arrows signify a column break.

7
To CREATE a break line, click at the desired position.

To DELETE a break line, double click on the line.
To MOVE a break line, click and drag it.

\.

W02345
¥Yo0345
IE346

Next >
First column remains General.

Second column, change General for Text
Finish
Y Convert Text to Columns Wizard - Step 3 of 3
i
This screen lets you select each column and set the Data Format
Column data format
_) General
Oex remaining values to text.
Date YMD Advanced...

Do not jmport column (skip)

Destination:  $A$9

Data preview

"General' converts numeric values to numbers, date values to dal

9 |AW

10 |y

11 |LI
|

02345
00345
8346
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17.3. Convert dates stored as text to turn it into date format
Type a date like this: (DD-MM-YYYY), 25-12-2023

Notice that EXCEL does not recognize this date

Click Convert

Immediately move to Step 3 of 3

Choose: DATE

Choose from the drop-down list the date format we typed: DMY
Click Finish

N o o~ w D RE

7 = =7 -

Convert Text to Columns Wizard - Step 3 of 3

This screen lets you select each column and set the Data Format.

Column data farmat

() General

‘General’ converts numeric values to numbers, date values
OIEH to dates, and all remaining values to text.
(® Date: | INTANNNDNNN - Advanced...

O Do not import column [skip)

Destination: | 54537

[

Data preview

< >

Cancel < Back Mext >

Note
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18. NAME MANAGER

A name is an evocative alias that allows you to immediately know the function of a cell reference, a
constant, a formula or a table that might otherwise be difficult to guess at first.

After selecting the range to be named, use

Formulas tab » Define name

New Name

Name: Namel

T
- @ Define Mame SOPE  [Workbook >
Comment:

<, Use in Formula ~
Mame

Manager BZ Create from Selection

13

Refersto: | _siatistics!9AS1:5F51

Defined Mames Cancel

OR

After selecting the range, click on the left portion of the formula bar and enter the name:

A8 ~ )i f.i: AVERAGE (TO BE CHANGE FOR MIN OR MAX)

A B
REGISTRATION FOR THE YEAR

OR

After selecting Create from Selection from the Formulas tab

REGISTRATION FOR THE YEAR 2019-2020

Create Mames from Selection

TRAINING IN OFFICE Sess| Create names from values in the: (
WORD Ll W
Left column
EALE. |:| EBottom row
POWERPOINT [] right column

ACCESS

To name a cell or cell range:

Select a cell or range of cells you want to name.

Click in the Name area, to the left of the formula bar.

Enter a name that will serve as a reference for the cell. Validate by pressing the Enter button.

L. O G G
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18.1. The few rules for using a name:

X The first character of the name must be a letter, an underline () or a dash (-). Afterwards
you can use letters, numbers, underline, or the dot. Your name should not exceed 255
characters.

X Upper and lower case are not considered, in other words, an upper case is equivalent to a
lower-case letter. So, CLINIC is the same as clinic, Excel won't tell the difference between
the two.

X Make sure that the name used does not correspond to a cell. For example, F7 is a cell, so it
is forbidden to use its name.

x  Finally, the name used may refer to an area (thus a cell range), but it may also have as a
scope a sheet or a workbook.

18.2. Open the Name Manager dialog box
X in the Formulas tab, in the Defined Names group,
<T‘ @Deﬂne Mame -~
G Uze in Formula ~
Mame
Manager B Create from Selection
Defined Mames
X Show names
—
Février 1 | B [ T D | E |
18.3. Reach a range name o 2 i, Que c'est Bon!
Once you've set the name of a range, you can easily reach | 2 | Place Versailles

the range from the Name Box of the formula bar.

18.4. Use a range name in a function

Les chiffres r

les

d

w

q ités de boites

pour chague produit

PRODUITS

=

Janvier Février

Mars Trimestre 1

£

Rocher au lait

100]

308

102

=

Rocher noir

200]

201

202

Range names are useful for creating a formula. Instead of entering the Address of a range, we can use its

name. Example: VLOOKUP or a formula

PRODUCTS

January February March

Black Rock 200 201 202

3| Coconut 150 308 152

Almond Black 304 206
504
501
351
500
326

411

302
282
502
352
177
327
412

Black and Mint

Truffe 500
350
175
325

410

Stuffed Heart

Fruity Night

w @ - & o

Amandine

Hazelnut

11| TOTAL

EXCEL ADVANCED

Page |22



FORMATION CAD INC

18.5. Delete a range name
X From the Formulas tab » Name Manager

X Select the name to be deleted and choose "Delete" from the "Name Manager" dialog
box

Name Manager

Mew... Edit... Delete Filter~

Name Value Refers To Scope Comment

Ff session2
B session3

19. Function VLOOKUP

Search functions allow you to search for a value in a table, for example: a name, a product number, invoice

number, phone

, address, etc.

Definition: This feature searches for a value in the first column of a table, which returns the value contained
on the same row and in another column.

Dialog box "FUNCTION ARGUMENT"

VLOOKUP

Lookup_value Identifies the cell that contains the value that the function looks for in the first
column of the table

Table_array Identifies the range (either by an already defined name or by the data
selection) in which the value search is performed

Col_index_num Shows which column the value is in. The columns are numbered from the left.

Range_lookup Enter TRUE if you want the function to return the value closest to the

one requested "This argument is optional”. Enter FALSE if you only want
exact values. If no value is linked to it, this feature will return #N/A. If you
don't specify it, EXCEL assumes that the value is TRUE

19.1. How to change the columns display to numbers

From the "File" tab, "Options" and "Formulas", check: R1C1 reference style in "Working with

formulas."

Excel Options

General

Formulas

Data

Proofing

Save

Language

Ease of Access
Advanced
Customize Ribbon

Quick Access Toolbar

Change options related to formula calculation, performance, and error handling.

Calculation options

Workbook Calculation Enable iterative calculation

® Autornatic Maximum lterations: | 100

Automatic except for data tables Maximum Change:  |0,001

Manual

Working with formulas

v Formula AuteComplete
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19.2. EXERCISE VLOOKUP

Look for the name of the company for which the customer number is "VS-1255", How to do it?

Open the file "Travel _VLookUp"
1. To make it easier, you'll give your data range a name, select the range Al to J308 from the
"Customer" sheet.

A B C D E
CUSTOMER  Gender
1 (1) ~ (2} - CUSTOMER (3) - D.O.B. (4)~ Age (5~
2 W5-1255 M Claude Patry 2013-04-11 10
3 WS-1444 M Peater Schweitzer 2012-02-22 11
4 VS-1457 M Pierre-Luc Brisson 2011-08-17 12
5 W5-1496 M Tony Gingras 2011-08-26 12
6 V51212 W Ann Clyde 2009-11-23 13
7 WS-1227 M Bernard Pierrot 2009-11-16 13
8 W5-1326 M Joél Hanna 2009-11-23 13

2. Fromthe wFormulas tab » Define Name» type "Customer” in » New Name
3. Also give a name from sheet "Travel" Example "City"

.ew Name O X

New Name a X
Name: Customer| Name: City
Scope: Workbook o Scope: Workbook

Comment: Comment:

>
1»

Refersto: - cystomer!$A$1:5J5308 Refersto: | ~city1sas1:58$12]

oK | Cancel oK | Cancel

Return to sheet "Invoice", click in cell B5 to search for the customer's name "VS-1227".

5. Click» Lookup & Reference » Formula Tab, choose
» VLOOKUP

VLOOKUP

You are now in the "Function Arguments" dialog box.

7. Lookup_value is the "VS-1227" customer number, so you need to click cell F5, which
represents the desired value

8. Table_array: Enter the name of the table "Customer™"

Col_index_num is the column number of the argument you're looking for, i.e. that the
customer's name is located in column Number 2, insert the number "3"

10. Range_lookup: type FALSE or value O
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11.
12.
13.
14.
15.
16.

Function Arguments

VLOOKUP
Lookup_value | 5F55| + | = Vs-1227
Mo
Table_array | Customer 4 | = CUSTOMER [1)"'Sex (2] CUSTOMER
[House} (10)7;"V5-1255" " M™ " Claude P
Col_index_num |3 + | = 3
Range_lookup |0 4 | = FALSE False or O

= “Bernard Pierrot®

Looks for a value in the leftmaost column of a table, and then returns a value in the same row from a column you
specify, By default, the table must be sorted in an ascending order,

Lookup_walue is the value to be found in the first column of the table, and can be a
value, a reference, or a text string.

Formula result = Bernard Pierrot

Help on this function Cancel
Click OK

Answer: =VLOOKUP(F5;Customer;3;False)

To save time » Lock F5 » $F3$5

Repeat the same steps to search for the address, and contacts.
See the table on the next page for column number identification.
In cells F11 and F12, VLOOKUP to get the amount of the trip

If the F12 cell is empty, a formula must be inserted to eliminate an N/A value when the

sheet will be protected in writing.

=IF(ISBLANK(A10);"";VLOOKUP(A10;City;2;0))

20. Function HLOOKUP

Definition of HLOOKUP: Finds a value in the top row of a table, and then returns a value in the same
column from a specific row.

Our goalis to "GET A DISCOUNT BASED ON THE COST OF THE TRIP"

N o oo s~ N

To save time, open the workbook "Invoice - Answer " sheet.
Please delete the answer in cell "F16"

Objective: redo the formula HLOOKUP

In cell "F16" activate "HLOOKUP

"Lookup_value"is "F15"

"Table_array" select the "DISCOUNTS - FEES" sheet, cell from "A2 to F3".

"Row_index_num", enter the number "2".
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8. "Range_lookup", enter the number "1"

Function Arguments ? X

HLOOKUP
Lookup_value |Fi 5| = 2775
Table_array | 'DISCOUNTS - FEES'AZ:F3 = {"Amount Purchases"\0\200\1000,2500\5000;"D...

Row_index_num | 2 z

I | 1=e | = =
n

Range_lockup |1 = TRUE

= 02
Looks for a value in the top row of a table or array of values and returns the value in the e column from a row you specify.

Lookup_value s the value to be found in first row of the table and can be a value, a reference, or a text

Formula result =

Help on this function

y "4
9. Answeris "0,2" — 20% discount, then multiply by "F15"

=HLOOKUP(F15;'DISCOUNTS - FEES'IAZ:F3;2;1)*F15

A t Purch )
mount Purchases 0 200 1000 2500 5000
ELLTI 0% 50 15% 20% 25%

21. CIRCULAR REFERENCES

A formula cannot refer to itself or to another cell whose formula refers to itself. So, if in cell A1 you write
=A1 or =A2+A3 while the formula in A3 is =A1, Excel warns you of the presence of a circular reference.
Correct the formula AUDITS AND CHECKS

4 Trace Precedents 7f~; Show Formulas

Eg,a Trace Dependents [i\;/ Error Checking

F; Remove Arrows v @ Evaluate Formula

Formula Auditing

21.1. To view and print formulas
Save your workbook to save the final version of your table, then:

1. Click the formulas tab + Formula Auditing + Show Formulas.

2. Check the preview before you print: your table should fit on a single page
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21.2. To identify precedents and dependents

1.
2.

Go to a cell containing a formula
Click the Formulas tab + Trace Precedents

X The cells used by the formula will be visualized.
Go to a cell containing a number

Click the Formulas tab + Trace Dependents

X The formulas that use the cell will be visualized.

21.3. To remove audit arrows:

X Click the Formulas tab + Remove Arrows

EL_-, Trace Precedents Vfr Show Formulas

"_"E| Trace Dependents /i‘;x Error Checking ~

-[N_;q Remove Arrows ~ @ Evaluate Formula

Formula Auditing

22. Pivot Table

The Pivot Table (PT or report) is a multidimensional database analysis tool. It is dynamic because any
change in the source results in the report being updated when the update is triggered. The PT allows you
to quickly group, combine and compare a lot of information.

Each column header in the database becomes a pivot table field. Each next row corresponds to a record.

The presentation of the summary table is defined by the filter and grouping options, the position of the fields
and the formulas applied. The PT allows predefined calculations (sum, number, count, average, product,
numbers, max, min, stdev, stdevp, var, varp). You can also create your own formulas by inserting calculated
fields and elements.

The effectiveness of a pivot table is based on a properly structured database.

Each cell in the first row contains the name of the fields (header).

)

) G D GHED GHED

The following rows contain the recordings.

The database should not contain two identical field names.
Avoid empty cells in fields that store numerical data.

The database should not contain empty columns.

The database should not contain empty rows.

The database should store only raw data (no sub-total rows)
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File

All the most appropriate commands are in the two context tabs: PivotTable Analyze and Design

Home  Insert
. . —
PivotTable Analyze Design ﬁ? =) —
[ﬂ ?
i [ﬂ?q i?]] PivotTable Recomménded Tab
1= Pi €
Actions | Calculations | PivotChart WotTables
v v Tahlac

File Home

Insert Page Layout

Formulas Data

Review View

~| Row Headers

Banded Rows

Help PivotTable Analyze Design 1 Share I Comm
PivotTable Name: | Active Field: . F\ = iz D [m i@ Clear~ [ Fields, Items, & Sets ~ =] =] [3] Field List
= Sy ANEE ) 3 i — - il 0
PivotTable2 B T & e [TR select ~ G i ? B +/- Buttons
= Insert  Insert Refresh Change Data | - o PivotChart Recommended
[@options ~ | [F | & Slicer Timeline ~ Source~ | [I3MovePivotTable | =3 PivotTables | = Field Headers
PivotTable Active Field Group Filter Data Actions Calculations Tools Show
File Home Insert Page Layout Formulas Data Review View Help PivotTable Analyze Design

ifsEls Fend bigan - HEnis ~| Column Headers Banded Columns =
= Totals ~ | Layout ~ Rows ~
Layout PivotTable Style Options PivotTable Styles

The pivot table command is very useful when you need to filter multiple fields from the same list (database).

This command creates a table that calculates values using a synthesis function, such as "Sum", "Average",
and other...

At the last step of this assistance, EXCEL creates a table template in which you can drag different fields
from your list. Excel gives names to fields, here are the names with the definitions:

22.1. Start the PIVOT TABLE
1. Select a single cell from the database
2.  Fromthe winsert tab »Click » Pivot Table
- Choose the data that you want to analyze
File Home  Insert D
Iable/Range:  Movies!SAS1:5I5109 * ‘
o= | 'I'I' (O Use an external data source ‘
|:| r? |
i 1 1 o 3
PiUDtTEh'E RECDr‘r‘Ir‘r‘IEr‘ldEd TEhlE :hfosewheve you want the PivotTable report to be placed
PivotTables : ?M.“;\:"k;x
Location: +
Tables Zhoose whether you want to analyze multiple tables
"1 Add this data to the Data Model
oK Cancel
3. Select data to be analyzed as needed
4. Or use another external data source
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5.

6.

Determine where you want Excel to display your pivot table
X In a new sheet or an existing sheet

Click» OK

22.2. ELEMENTS OF A PIVOT TABLE

| — | PivotTable Fields v B

Choose fields to add to report: v

To build a report, choose fields e 2
from the PivotTable Field List Fa— :

[ Language

[ Title

[] WinnerQSCAR

[] Distributor

[ Cost

— [ Quantity

[ Supplier hd

Drag fields between areas below:

LRI
-]
]

Rows = Values

Defer Layout Update

22.2.1. Filters and Slicer

)

) G D GHED GEED

This field is used to extract data according to the selected item. This field represents the
Page Field.

Now, if more than a filter, we will use the Slicer

= =

Insert  Insert
Slicer Timeline

Filter

The "Filters" area is used to hide or display subgroups of data in the pivot table.
New cells, including an icon, appear in the spreadsheet, just above the PT.
Click on the icon to see the window that lists the elements of the filter field.

The unchecked items are not considered in the report.

Each time one or more items are checked in the choice list; the pivot table is updated and
presents only the corresponding filtered data.

A filter icon (funnel-shaped image) is displayed in the PT when elements are filtered.

A filter icon also appears on the right of the name, in the "Pivot Table Fields" window. You
can also filter the field by clicking this button.

You can also accumulate and sort multiple fields in the filter area of the report.
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22.2.2. Rows

x

The values of this field are arranged horizontally.
Every element of this field is displayed on a row.

22.2.3. Columns

)

The values are arranged vertically.
Every element of this field is displayed in a column.

22.2.4. Data field or Values

X The datain this field is used to make the calculations.
v Filters Column field
WinnerOSCAR  (All) o hd
Category 9
Sum of Quantity Movies |~
Language ~ | Distributor - | Action Adult Cartoons Comedy General Horror Tragedy Grand Total
-E 9 Alliance 64 89 153
A Columbia Pictures 75 64 152 291
FoxVideo 4 75 75 64 89 77 380
Paramount Pictures 89 174 263
Universal Pictyres 91 76 7 244
Walt Disney 271 271
Warner Bros. 64 64
E Total 394 75 204 153 840 1666
=F Alliance 142 319 217 678
Columbia Pictyres 418 103 A 166 89 778
Fox Video 256 77 166 6 99 524 1122
Imavision 21 164 89 64 125 1731 307 922
Paramount Pictures 182 341 200 115 455 1293
Universal Pictyres 98 71 83 86 81 419
Walt Disney 286 75 75 263 75 467 1241
Warner Bros. 237 83 89 99 442 950
F Total 1641 231 326 978 1095 548 2582 7401
Grahd Total 2035 231 401 1182 1095 701 3422 9067
Row field * Data field

22.3. View and hide

)

The "Field List" button hides and displays the "PivotTable Fields" window. The "hidden"
setting prevents the window from being automatically displayed when a report cell is
selected.

"+/- Buttons" allows you to display or hide the develop/reduce buttons in the report.

The "Field Headers" option hides and displays the field headers of the rows and columns.
=| EIEI —

Field +/- Field
List ||Buttons|{Headers

Show
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22.4. Active field

X You can read or change the name of the active field from the input area

X When you select rows or columns labels, the two buttons containing a "greener" and a "less
red" button are available. The 'Plus' expands all the elements of the active field and the
'Minus' collapses all elements of the active field.

-= Collapse Field . .
To hide the details

+= Expand Field

To view more details
X  The "Field Settings" button shows the dialog box of the same name, depending on the
active cell.

Active Field: +Z Bpand Field

Category Movies

@ T ~= Collapse Field

Active Field

22.4 1. Field settings — Summarize Values - Common operations

e Field Settings ? X
Source Name: Quantity

Custom Name: |Sum of Quantity

Summarize Values By Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize
data from the selected field Summarize Walues By > ~  Sum

T Count
’;".:):Ege += Show Details Acerage
hin v f= WValue Ficld Scttings... Max
PivotTable Options... Min
X "Sum" returns the sum of all the values of the field.
X "Count" returns the number of records in the field.
X "Average" returns the average of all the values in this field.
X "Max" returns the highest value of the field.
X "Min" returns the smallest value of the field.
X "Product" multiplies all the values of the field.
X "Count Numbers" returns the number of digital records in the field.
x  "StdDev" returns the standard deviation of the field.
x  "StdDevp" returns the standard deviation of a population.
X "Var" returns the variance of the field.
X "Varp" returns the variance of a population.
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22.5.

Field settings — Show values

X "No calculation" uses routine operations.

o o ox X

(Grand Total of the column)).

) ¢

"% of Row Total" calculates the percentage of the row’s total.
"% of Column Total" calculates the percentage of the column’s total.
"% of Grand Total" calculates the percentage of the overall total.

"Index" calculates relatively ((value in cell) x (Grand Total)) / (Grand Total of the line) x

"Running Total In" calculates a cumulative total for the base field.

"Difference from" calculates the percentage difference relative to the value of the base
item in the Base Field.

"% of" calculates the percentage of the value of the base item in the Base Field.

"% Difference From" calculates the percentage relative to the value of the base item in

the Base Field.

pannn e

I | Search the menus ‘

@ copy
Format Cells...
Number Format...
D@ Refresh
Sort >
X Remove "Sum of SALES"
Summarize Values By >
Show Values As >
Tj Show Details
[ Value Field Settings...

PivotTable Qptions...

Hide Field List

El

Wine Calculated field Pal

~ No Calculation
% of Grand Total
% of Column Total
% of Row Total
% Of...
% of Parent Row Total
% of Parent Column Total
% of Parent Total...
Difference From...
% Difference From...
Running Total In...

% Running Total In...

Rank Smallest to Largest...

Rank Largest to Smallest...

Index

J

Value Field Settings

Source Name: Quantity

LCustom Name:

Summarize Values By
Show values as

Mo Calculation

5um of Quantity

Show Walues As

Mo Calculation

% of Grand Total
% of Column Total
% of Row Total

% Of

Humber Format

| oK | | Cancel

The "Field Settings" window also contains other information and options:

X The name of the source field.

X The custom name that appears in the report and that is changeable.

®  The "Number Format" button to customize the values presented in the PT. This will freeze
the field format even if the data is changed or moved.

X You can accumulate multiple summaries of the same field in the area. Then assign a type of
calculation to each. This allows you to quickly visualize additional information on the field to

be analyzed.
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22.6. Sort

The "Sort" group allows you to sort the selection in ascending or decreasing order. If you 1\ | /
have any doubts about the result (depending on the cell selected), click the "Sort by value”
button beforehand. The window contains a description of the sorting that will be done. g

We will get this option with the right click mouse button.

Sort > 2| sertatez
Filter > %] sertZtoa
¥ Subtotal "Distributor” More Sort Options...

22.7. Group Selection

The "Group selection" button creates a set from the items you select in the report.

X When you expand the group, each item value will appear
separately. When the group is collapsed, the PT displays the — Group Selection

total of the constituent elements. -
2H Ungroup

The "Ungroup" allows you to delete the selected group. E

The "Group field" button allows you to summarize numerical
or Date elements in the report. For example, select a date in Group
the PT and then click the "Group Field" button: Choose the type
of grouping (per month).

Row Labels - | Count of Age Row Labels |~ Sum of Salary week NEATHT
20-29 5 +2008 11 795,50 $
30-39 17 #2009 441200 § |
|40-49 18] | [ [=2010 I 6 599,00 § | [dstartingat: |2008-03-21
50-59 5 #2011 18 054,50 $ Ending at: | 2020-10-27
Grand Total 45 +2012 13 312,50 $ By
+2013 7 232,00 $ ceconde
Grouping ? X +2014 808500 § Minutes
+2015 5978,00 % Hours
| 2016 2571275 $ | ;e
[ startingat: |0 #2017 23 287,00 §
Endingat |59 +2018 10 385,00 %
By 10 #2019 17 216,50 § Mumber of days: |1 =
+2020 5 316,00 $
p— Grand Total 157 385,75 $ pe—

The pivot table then returns the elements grouped according to the chosen element:

You can select multiple group options at the same time. Click the "Ungroup" button to
remove groups.

X Numerical elements can be grouped in the same way. Example for grouping values by ten:
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22.8. Actions
The "Clear" button contains two options that delete the entire pivot table
or delete all filters in the report.

The "Select" button allows you to quickly activate certain cells in the
report:

Labels and values.

Labels alone. Iﬁ?}l \iﬂ @

) GID GID QN

Values alone.

. . ) Clear Select  Move
The entire pivot table. Make sure the "Enable Selection” . v PivotTable
option is enabled and that the full PT is selected to un-grey
the menus. Actions

The "Move Pivot Table" button changes the location of the report to
another cell in the workbook or to a new sheet. This method keeps your
custom cell formatting after moving.

22.9. Data group

Refresh Change Data
v Source ¥

\ Data

22.9.1. Refresh data

X |tis important to always refresh the data when you're working

22.9.2. Change the date source

x Also, make sure the pivot table includes all the new data

22.10. Pivot table options

The "Options" button displays the "Pivot Table Options" dialog box. The window is made up of 5 tabs.

E Options ~
PivotTable
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"Layout & Format" tab

Merge and center the cells with labels.

Indent row labels when the report is in compact
mode (between 0 and 127 characters).

Sets the display order of the filter fields (Down,
then over or Over, then down).

Assigns value to empty cells. Indicate O in the
numerical fields, to make later calculations more
reliable.

Preserve cells formatting when updating data.

The "Totals and Filters" tab

PivotTable Options

PivotTable Mame: PivatTabIeEl

Layout & Format  Totals & Filters  Display  Printing Data Alt Text
Layout
D Merge and center cells with labels

‘When in compact form indent row labels: |1 3| character(s)

Display fields in report filter area: | Down, Then Over |~

Report filter fields per column: |0 S
Farmat

[] For errar values show:

For empty cells show:

Autofit column widths on update
] Breserve cell formatting on update

)

Shows or hides row and column totals
Adds or removes filtered items in sub-totals.

Allows multiple filters per field (to use all values
in sub-totals and grand totals, otherwise the
calculation will not consider hidden/filtered
items).

The "Display” tab

PivotTable Options

PivotTable Mame: PivotTable5

Layout & Format ! Display  Printing Data Alt Text
Grand Totals

Show grand totals for rows

Show grand totals for columns
Filters

Subtotal filtered page items

I:‘ Allow multiple filters per field

Sorting

Use Custom Lists when sorting

Shows or hides expand/collapse buttons

Shows or hides the tooltips that appear when
you move the mouse over a value cell in the
report. The tooltip info returns the name of the
field, the value, as well as the names of row and
column labels.

The "Classic layout" option allows you to
drag/drop.

Shows or hides line items that do not contain
value.

PivotTable Options

PivotTable Mame: | PivotTable5

! Printing  Data  AltText

Layout & Format  Totals & Filters

Display
Show expand/collapse buttons

Show contextual tooltips
Show properties in tooltips

gisplayfield captions and filter drop downs
D Classic PivotTable layout (enables dragging of fields in the grid)
D Show the Values row

Show items with no data on rows

Show items with no data on columns

Display item labels when no fields are in the values area

Field List

O SortAtoZ
@ Sort in data source order
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The "Printing" tab

X Prints expand/collapse buttons. It is best to
uncheck this option to improve the readability of
the print.

X The option "Repeat row labels on each printed
page".

X Set print titles: repeats column headers, rows,
and column labels for all printed pages.

The "Data” tab

PivotTable Options

PivotTable Mame: | PivotTableS

Layout & Format ~ Totals & Filters  Display | Data  AltText

Print
D Print expand/collapse buttons when displayed on PivotTable
Repeat row labels on each printed page
Dget print titles

X The "Save source data with file" option backs up data
from the external source with the workbook.

X "Enable show details" to extract and view data detail
in a new spreadsheet.

X Refresh data when opening the file.

22.11. Design tab

Layout

PivotTable Options

PivotTable Mame: | PivotTables

layout & Format ~ Totals & Filters  Display  Printing | 1Al Text

PivotTable Data

Save source data with file

Enable show details

D Refresh data when opening the file
Retain items deleted from the data source

Number of items to retain per field: | Automatic |~
What-If Analysis

Enable cell editing in the values area

X  The "Subtotals" button allows you to: not display sub-totals. Show all sub-totals at the
bottom of the group. Show all sub-totals at the top of the group.

X  The "Grand Totals" button allows you to: Turn off for lines and columns. Turn on for lines
and columns. Turn on for lines only. Turn on for columns only.

X  The "Report Layout" button defines the type of pivot table. Compact form is the default
format under Excel2007. In Outline form, each row label has its own column. Tabular form

displays the data as a table.

»  The "Blank Rows" button inserts or removes a blank line between each group of items.
The insertion of lines spreads and improves the presentation of the report.

H B E E

Subtotals Grand Report  Blank
v Totals ¥ ' Layout ¥ Rows v~

Layout

\\7/
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Style

X The checkboxes define the behavior of the style applied to the PT. Options make it easier to

format and read the report.

PivotTable Styles

X Row Headers displays a formatting on the first row of the report.
X Column headers display a particular formatting on the first column of the report.
X Banded Rows allows different colors to be applied between the even and odd rows of the
report.
x  Banded columns offer different colors to be applied between the even and odd columns of
the report.
*| Row Headers Banded Rows
*| Column Headers Banded Columns
PivotTable Style Options

X This option allows you to choose a style of presentation from a wide range of predefined

formats.

X Click in the lower right corner of the drop-down menu to see the different styles. You can
also remove a style from the list or add a custom style. A custom style can be defined as the

quick style of the default pivot table, for the document.

22.12. Calculations

Calculated fields

If the predefined formulas are not enough to summarize the value fields, you can create personal functions
tailored to your project. These formulas are called calculated fields and calculated elements.

The calculated fields are based on data from other fields. To
create the formula, select the "Analyse" tab in the ribbon. Click the
"Fields, Items, & Sets" button in the "Calculations" group. Choose the
"Calculated Field" option. Name your formula in the "Name" zone. It
is also in this drop-down menu that you select an existing calculated
field to change or delete it.

Fields, ltems,
& Sets ~

Calculations
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Example: To find the total price of wine in "Stock” per country

ig O =5 | [4

Fields, [termns, PivotChal
8 Sets ~

Calculated Field...

Calculated [tem...

Solve Order...

ﬁ List Formulas |

Create a Pivot Table

Name: type "Taxes"

Click OK

© N o g bk~ w D PRE

See your result

Formulas: = TotalSales*14.975%

Choose "Calculated Field" » Group Calculations

Open "Pivot Table" » Workbook » "Supermarket" sheet

Insert "Products” in row label and "TotalSales" to "Values"

A B

000~ | d | ha =

Insert Calculated Field

11 Mame: Taxes

12 | | Formula: | =Totakales' *14,975%

15 Fields:

Products
1T— | | Category
18 | | Farm
19 Amount sold (kg)
| | Unit price
20— | | Totalsales

21_ | | Taxes

Row Labels ~| Sum of TotalSales

Fine herbs 621584 §
Fruits 675220 $
Vegetables 1549720 $
|Grand Total 28 465,24 $

16 | | I

Insert Figld

Sum of Taxe:
930,82 §
1011,14 4
232071 §

4 262,67 $

([

Maodify

Delete

oK

Close
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22.13.

Insert Slicer

A Slicer is a filter, instead of using the "Filter" field, we'll use "Insert Slicer" because we have
multiple elements. The "SLICER" is very visual and interesting.

Slicer

= B
Insert Filter

Filter

imeline Connections

File
Slicer Caption:
|Doctor's name |

E| Slicer Settings

Slicer

Report
Connections

Slicer Styles

Home Insert Page Layout Formulas Data Review View Developer Help

——
I:EIIEI

E
th

- Bring

B S EEA

Send  Selection Align

Forward ¥ Backward ~  Pane v

Arrange

[T columns: |‘3
1M Height [065cm |

HIL

Shwidin: [27em -

Buttons

eight: {8‘19 cm

size

Ewidth: 11,73 cm

&

Let’s take the example of the “Patient” sheet of the “Pivot Table” Workbook
You would like to know the number of appointments per site

)
)
x
x

Place "Site" in "Rows" and "Date of Appointment" in "Values"

"Insert Segment" choose "Specialty".

Choose: Cardiology — Surgery — General — Obstetrics.

Expand the box if necessary to see all the specialties

ylousee all he specilties

Specialty v= ¢ ; Doctor's name v=

[ Cardiology ] I Adili, Ron H Beaulieu, Claude H Camejo, Oscar l
Endocrinology l Chang, Lee H Gaudron, Victoire H Korba, Nicholas I

[ General ] I Marchand, Paul H Michaud, Héléne H Papineau, Monika l
Gynecology l Parulis, Christina H Rondeau, Roméo H Solomon, Wendy I
Neurclogy ‘iLSuban, Ron H Watson, Ana ] Barber, Johnny

[ Obstetrics l Berlin, Jared Bertrand, Victoire Bouchard, Etienne
Rheumatology Caron, Pierre-Paul | Charland, Antoine | Drouin, Pierre

[ Surgery l Faulkner, France Garon, Robert Gibson, Anne
Urology Ortiz, Francesco Price, Lori Weissman, Kimb...

Now you want to choose some doctors.

Return to "Insert Slicer" choose "Doctor’s Name"

Observe that the doctors who are dark blue represent those who are selected in the

specialty.
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X Now choose a few doctors like this (Blue selection)

N
= ¥

Beaulieu, Claude Camejo, Oscar
Gaudron, Victoire Korba, Nicholas

7
Specialty Y= 52 |[ Doctor's name
 Cardiology ||| Adii, Ron
[ General ] Chang, Lee
[ Surgery ] [ Marchand, Paul

H Michaud, Héléne I Papineau, Monika

Endocrinelogy

Parulis, Christina Rondeau, Roméo
\. Suban, Ron Watson, Ana

Solomon, Wendy

Barber, Johnny

v

Rheumatology Faulkner, Franc

Urology

Gynecology
Neurclogy Berlin, Jared
Obstetrics Caron, Pierre-Paul

Ortiz, Francesco

Bertrand, Victoire Bouchard, Etienne

Charland, Antoine Drouin, Pierre
e Garon, Robert Gibson, Anne

Price, Lori Weissman, Kimb...

X Look again "Specialty"

“Obstetrics” is grayed out, which means the doctor was not selected.

X Also note that we have “3 Columns” for doctors, it's up to you to decide the number of

columns you want to see and the necessary width.

DIl Columns: |\3 : |
T IHeight: 065 cm 2 |
Bwidth: [37em 1)

Buttons

I Height:[819cm |

Fwidth: [1173cm | |

Size

1

X You have also "Slicer Styles"

Slicer Styles

<]

X To remove A filter of "Doctor’s name" or from "Specialty" click on

NOTE
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22.14. Insert Timeline

A "Timeline " is a “Slicer” with "date "

=
=

Filter
imeline Connections

Filter

We will continue the previous exercise with " Timeline"

In "Timeline ", we have 4 choices:

)

YEARS

YEARS
®  QUARTERS QUARTERS
x MONTHS v  MONTHS
DAYS
X  DAYS

Let’s take again “Patient” sheet of the “Pivot Table” Workbook
You would like to know the number of appointments per site,

) GIED GEED GEED

Place "Site" in "Rows" and "Date of Appointment" in "Values"

Choose the month of November 2023 and select date to the end of February 2024
First, choose "MONTHS"

Then click in Nov 2023, with the moose, move to Feb 2024

A

lDate of appointmen] T
nov 2023 - féyr 2024 J MOIS
)2023 20ad
SEPT ocT NOV DEC JANV FEVR naRS AVR MAI JUIN JUIL A00T SEP
— e
4 b
Modify "MONTHS" for "DAYS"
Select the first 10 days of November 2023
Date of appointmena ¥ Tx Y

1-10nov 2023

OCT 2023 NOWV 2023

21 22 23 24 25 26 27 28 29 30 311 2 3 4 5

3]

7

g

9

¢
1 12
— s e e — —————

~
{Y

4

re
{
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23. Data validation

Data validation controls the type of data and values that users enter a cell. For example, you may want to
restrict data entry to a certain range of dates, limit the choices available by using a list, or make sure that
only whole numbers have entered.

This article describes how data validation works in Excel and presents the different techniques available. It
does not address cell protection, that is, the feature that allows you to "lock" or hide certain cells in a
spreadsheet to prevent data from being changed or replaced.

23.1. What is validation?

Data validation is an Excel feature that sets restrictions on the type and values of data allowed in a cell.
You can set up data validation to prevent users from entering data that is not valid. If you prefer, you can
allow users to enter invalid data but notify them when they type it into cells. You also can display messages
detailing the type of input expected for cells, as well as instructions to help users correct errors.

If users ignore this message and type invalid data into the cell, such as a two- or five-digit number, you can
display an error message.

I . v
\/ s Data validation commands are located under the Data tab in g\
<' the Data Tools group. )
Data
Validation ~
Be careful, you must respect the case

23.2.  When to use data validation?

Data validation is particularly useful when sharing a workbook with others in your organization, for which
you want the data entered to be accurate and consistent.

You can use data validation to perform, among other things, the following tasks:

23.3. Limit data with a list

1. Inanew sheet + in Pivot Table workbook, insert the column Payment Type into Al.

2. Select cell A2 or the entire A2:A10 range, then go to the Data Validation box

3. Select +List+ in Validation criteria » Allow 1 [Payment type C
4. Type in SOURCES: 5 -
5. Interac,Visa,Cash,MasterCard.

6. Click OK I visa

7. Watch the drop-down menu in the cell 4 MasterCard
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23.4. Limit data with a list with a name
1. Select data (In this example: Cities)
2. Name your list (In this example: CITY)
3. In"Date Validation" and then "Sources", type " =" and then the name you gave to the list
A B Data Validation
JfPESTINATION PRICE
[| Settings Input Message  Error Alert
2 -AMSTERDAM 2750 3 Validation criteria
3] BRUSSELS 2650 5 Allow:
4]|GENEVA 2800 § List ~ | [ 1gnore blank
5]|LisBON 3400 5 | Dat= B4 in-cell dropdown
6|/ LONDON 2550 between -
Source:
7§ MADRID 2500 5
1 =5453:54513) 1
8] MARSEILLE 2550 § .
I I = City Method 2
9| |MILAN N 3m0s
10 |PARIS 2450 § Apply these Yhanaes to all other cells with the same settings
14/ ROME 3100 3
1AZURICH J 26505 | SerAl Cancel
23.5. Limit data with a list by selection
1. Select cells to insert validation
2. In"Sources," click on the reference and select the data
23.6. Limit numbers outside of a specified range

In a particular cell, you can specify a minimum or maximum limit

Data Validation

Settings

Validation criteria
Allow:
hid
Data:
between ~

Minimum:

Maximum:

Input Message  Error Alert

Ignore blank

I

I+

23.7.

You can limit the authorized text in a cell to 10 characters or less.
Similarly, you can set the specific length of the number or text so
that it corresponds to the length, example: Maximum of 4

Allow:
characters. Textlengtn <] B tgnore ptank
Data:
equal to ~
Length:
4 +

Limit the number of text characters

Settings Input Message  Error Alert

Validation criteria
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23.8. Data validation messages

What users see when they enter invalid data into
a cell depends on how you set up data validation.
You can choose to display an input message
when the user selects the cell. Input messages
are generally used to offer users advice on the
type of data that can be entered into the cell. You
can move this message if you wish. It then
remains displayed until you move to another cell
or press Esc.

Management's message
Choose from the follocowing
list:

Interac:Visa; Cash:MasterCard

23.9.

Management"s message

Choose from the folloowing list:
Interac;Visa;Cash;MasterCard

Cancel Help

23.10. There are 3 types of error message:

Data Validation

Settings  Input Message  Error Alert

Show input message when cell is selected

When cell is selected, show this input message:
Title:
Management's message
Input message:

Choose from the folloowing list:
InteraqVisa;Cash;MasterCard|

Llear All

Cancel

View an error message for invalid data.

Prevent users from entering invalid data into a cell. A Stop Alert offers two

Warns users that the data entered is not valid, without preventing them from

Icon Type Use to
(:::]I Stop options: Retry or Cancel.
$ Warning
entry.
:ﬁ: Information

Cancel to opt out.

entering it. When a Warning message appears, users can click Yes to accept
the invalid entry, no to change the invalid entry, or Cancel to delete the invalid

Informs users that the data entered is not valid, without preventing them from
entering it. This type of error message is the most flexible. When an
Information message appears, users can click OK to accept the value or
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24. LIST OF SYMBOLS, CUSTOM FORMAT

Order Format / cell / numbers / custom category

Symbol Meaning

0 Always displays a number. If there is no number at this location, display a 0. For
example, code 0.00 always shows two decimal places.

# Shows a number only if there is one. Doesn’t show anything if there isn't one.

? Like code 0 but displays a space instead of non-significant zeros.
The comma serves as a decimal separator. Can be defined as a point in the

' Windows configuration panel.

% Converts the number into a percentage by multiplying by 100 and adding the
sign.

$ Shows the currency symbol.

) Shows parentheses.

Space The space is used to separate the thousands. Can be modified for a comma in

P the Windows configuration panel.

The underscore leaves a space of 1 character. Can be used to align numbers

- both in the column and on the decimal symbol.

d/mlyy Date format posted for January 5, 1985 - 5/1/85

dd-mmm-yyyy Date format posted for January 5, 1985 - 05-Jan-1985

dd/mmlyy Date format: posts 01/01/00 for January or 12/12/00 for December.

mmm Shows the abbreviated names of the month (Jan to Dec).

mmmm Shows the full name of the month (January to December).

yy Shows the double-digit year

yyyy Shows the four-digit year

H Shows hours without zero (1 to 23).

HH Shows hours with zero (01 to 23).

hh:mm Shows hours and minutes

0 Shows hours above 24 or minutes and seconds above 60. For example, [h]:mm
gives 72:00 if the cell contains the value 3.

[color] Shows according to the specified color. The available colors are black, blue,
cyan, green, magenta, red, white, or yellow. Example: [red].
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25. Error value

ERROR
VALUE

CAUSE AND SOLUTION

#VALUE!

Error due to invalid name

This error occurs when the app does not recognize the text contained in a formula.
» You used a cell name or cell range that does not exist.

» A name has been misspelled.

» Text was entered into a formula without being placed in quotation marks.

» A function has been misspelled.

#DIV/O

#NAME?

#REF!

#NUM!

Zero Division Error
» Entering a formula that makes an explicit O division: for example, = 5/0
» Using a reference to an empty cell or a cell containing 0 as a divider.

Error due to invalid name

This error occurs when the app does not recognize the text contained in a formula.
» You used a cell name or cell range that does not exist.

» A name has been misspelled.

» Text was entered into a formula without being placed in quotation marks.

» A function has been misspelled.

Invalid cell reference error

This error occurs when a cell's coordinates are not valid.

» You removed or merged cells that other formulas referred to.
» You used an invalid cell link.

Number error
This error occurs if a formula or function contains invalid numerical values.

» A number is too large or too small to be represented in Excel. Values must range from||
-1*10%°7 and 1*103%07

» A function that runs by iteration fails to find a result.
» You used an incorrect argument in a function that requires a numerical argument.

#N/A

Missing value error

This error occurs when a value necessary for the formula to function properly is missing.
» A mandatory argument in the formula is absent.

» An inappropriate argument is used in a formula.

» VLOOKUP, HLOOKUP or INDEX functions search an unsorted line or column.

#NULL!

Zero value error

This error occurs when you specify an intersection of two areas that do not intersect. Th
intersection operator is a character of spacing between references.

Example =SUM(A1 A10). The two points (:) are missing to separate the two cells.
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26.

Exercise Pivot Table

Open the workbook "Pivot Table

1.

Pivot Table: sheet: "Boutique"
X What is the total sales per season, view the values in $
X Add the "Category" field in Column Labels

x  Expand columns and make sure you keep the column
width when updating.

Pivot table: sheet: "Patient"

X How many patients per age group (Group of 20)?
X Rename this sheet: "Age group."”

X Add a chart to your Pivot Table (Pie)

Count of Age
1-20 145
21-40 552
41-60 405
61-80 598
81-100 256
Grand Total 1956

o} o d

Countof Age

Total

Age T

= 1-20

= 21-40
41-60

= 61-80

|

What is the number of patients per month, per site?
»  Show "Women" only
X Do you prefer to see "Site" in rows or columns labels?

x  Hide "Filed headers" and adjust all your columns

Gender w T

| Count of Date of appointment

| HD ND SL Grand Total
|janv 57 93 58 208
|févr 85 115 75 275
|mars 30 3 13 74
|avr 24 24 8 56
|mai 15 25 B 46
[Juin 3 3 1 7
|juil 26 27 1 54
|aodt 10 10 1 21
|sept 4 4
|nov 34 43 34 111
|déc 47 62 23 132
|Grand Total 331 437 220 988
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4, Pivot table: sheet: "Patient"

X What is the number of appointments per SITE, by SPECIALITY with the names of the
doctors? Here's your result, respect the titles and the graphic presentation

Do not forget to change your report layout in "Tabular Form"

Hide "Subtotal" from "Specialty"”

Count of Date of
Site ~ Specialty - Doctor's name - |appointment
- HD -ICardiclogy Chang, Lee 91
-IEndocrinology Faulkner, France 22
-IGeneral Beaulieu, Claude a0
Gaudron, Victoire 104
- Gynecology Caron, Pierre-Paul 189
-INeurology Gibson, Anne 28
+ Obstetrics 24
- Surgery Korba, Nicholas 71
- Urology Garon, Robert 45
HD Total 664
-IND -ICardiology Camejo, Oscar 47
-IEndocrinclogy Berlin, Jared 18
-General Adili, Ron 48
Michaud, Héléne 206
-IGynecology Price, Lori 285
-INeurclogy Ortiz, Francesco 27
+ Obstetrics 66
- Surgery Parulis, Christina 34
- Urology Weissman, Kimberly 33
ND Total 764
-I1SL -Cardiology Marchand, Paul 39
-IEndocrinology Bouchard, Etienne 28
-IGeneral Watson, Ana a7
-Gynecology Drouin, Pierre 118
-INeurclogy Barber, Johnny 108
+ Obstetrics 20
- Rheumatology Bertrand, Victoire 24
- Surgery FPapineau, Monika 29
- Urology Charland, Antoine 65
SL Total 528
Grand Total 1956
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